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Introduction 

 

This tutorial aims at introducing the user to the SCIA Engineer functionalities which are used in the 

design of a commercial steel building structure.  The functionality in this tutorial are consistent with 

those found in the Fundamentals Edition of SCIA Engineer.  Additionally, in order to properly 

understand the tutorial, the user must be familiar with the basic principles of the Finite Element Method.  

For more detailed information on the Finite Element Method and how it is utilized in SCIA Engineer, 

refer to the FEM Training Manual. 

 

In all, this tutorial consists of 7 parts including: 

 

Part 1 – Modeling 

Part 2 – Loading 

Part 3 – Analysis, Meshing & Results 

Part 4 – Steel Design (Columns, Braces, Joists) 

Part 5 – Composite Steel Design 

Part 6 – Concrete Shear Wall Design 

Part 7 – Engineering Report 

 

In Part 1 of the Commercial Steel Building tutorial, the functionality and features that are used to start a 

project and create the model of the structure will be discussed.   

 

 

http://downloads.scia.net/support/sciaengineer/manuals/15/fem/%5beng%5dtopic%20training%20-%20fem_15.1.106.pdf
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Getting Started 

Launching the Program 

To begin, open SCIA Engineer by double clicking on the desktop icon or by navigating to Start > All 

Programs > SCIA Engineer. 

  

 

 

 

   

 

Note: If no protection is found, a dialogue will appear with the limitations of the try-out/demo version.  

For more information on the protection and licensing of SCIA Engineer, visit the Documents section of 

the SCIA Engineer 15 downloads page. 

Starting a New Project 

Once SCIA Engineer has been opened, the Start Project dialogue box will appear.  Select the New 

Project tab and then double click on Analysis to start the project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Project Data window will now appear, for this project enter the options as shown in the picture 

below.  Changes to the materials can be made by using the drop down arrows below the checkboxes, 

however by default all types of concrete and steel will be available in the project.  Additionally, if the 

National Code is different than IBC, it can be modified by selecting the ellipsis button (3 dots) next to 

the current active code.  Once the inputs are complete, click OK to start the project. 

https://www.scia.net/en/support/downloads/scia-engineer-15
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Dot Grid Settings & Units 

Once the project data has been set and the graphical interface is open, the user can manipulate both 

the units for the project and dot grid spacing.  The units are accessed through the drop down menus, 

Setup > Units or by using the button on the Project toolbar.  For this project, we will use units of “ft” 

for length and “lbf” for loading. 

 

 

 

 

 

Note: If the Unit button does not show up on the Project toolbar, you will need to switch the current 

style of toolbars.  To do so, navigate to Setup > Options > Current Style of Toolbars > Full Toolbars.  

You will have to restart SCIA Engineer in order for the change to take effect. 

 

To access the dot grid, select the button located on the Tools toolbar or use the drop down menus, 

Tools > Dot Grid and Tracking Settings.  Within the dot grid settings, change the grid spacing to be 1 ft 

and click OK. 
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Import drawing in Graphical Window 

 

In many cases, the structural engineer has the opportunity to leverage external model data that was 

created by the architect in order to more efficiently create the analysis model.  This can be done using a 

variety of model exchanges (Revit, IFC, Rhino, etc.).  In this example, a file from AutoCAD will be used 

as the basis of the model. 

Import CAD Drawing (.dwg) for modeling 

In the Main service tree, double click                     to begin the process of modeling. To choose a .dwg 

to import into the project, double click on Import DWG, DXF, VRML97 within the Structure tree. 

 

 
 

The Open window appears and it is necessary to navigate to the location of the 

SteelBuildingPlan.dwg file on your local system.  This .dwg is supplied as part of the tutorial.  After 

the drawing is selected, click Open. 

 

 

The Import window will be displayed and some of the import parameters can be adapted before 

importing the drawing. 
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Layers: 

 Contains all layers that were defined 

in the original .dwg file 

 All layers are selected by default 

 

Entity Types: 

 Contains available entity types 

(lines, surfaces, solids, etc.) 

 All entities are selected by default 

 

Selection mode: 

 The selection mode of this project 

will be Lines 

 Other selection modes are based on 

the various entity types 

 

Scale: 

 The scale used for this import is 1:1 

 Based on the current units of a     

 .dwg and SCIA, the scale factor may 

         need to be changed 

Insertion Point: 

 Options include Centre (based on manual selection of point), Origin and Origin (0;0;0). 

 For this tutorial, the drawing will be imported at the origin (0;0;0) 

 

With the properties of the Import set as shown in the picture above, click Import All. 

 

Note: For more information concerning the import of geometry from CAD software, refer to the SCIA 

Engineer Online Help, Import into the Graphical Window.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Upon import, the drawing can be placed on a specific layer.  In this tutorial, click on the ellipsis button (3 

dots) in order to rename Layer 1 as REF and then click OK. 

http://help.scia.net/15.2/en/#rb/importexport/import_into_the_graphical_window.htm?Highlight=import
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The imported CAD drawing can now be used as a basis for the model.  Before, continuing it would be 

wise to save the file, using File > Save As. 
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Line grids & stories 

 

Before the structure is created, Line grids & stories should be added to the project as a means to 

organize data.  Additionally, Stories will be used to quickly view only elements on a specific level as 

well as reporting results for lateral loading.  To create these, open the functionality by doubling clicking 

on                                   in the main service tree. 

Line Grids 

For this example, a rectangular 2D Line grid will be used.  Click on the [+] to expand the 2D Line grid 

field and then double click on Rectangular grid.  Once the rectangular line grid dialogue appears, input 

the grid dimensions as shown in the picture below and click OK. 

 

 
 

Once the grid dimensions have been added, additional properties concerning the grids labels and 

dimensions can be manipulated as shown below.  When the changes have been made click OK. 

 

 



 

12 

 

The input location of the rectangular grid is based on the intersection point of Grid Lines A & 1 located 

in the bottom left corner of the structure.  Select that point as the base point to complete to input of the 

2D Rectangular Line grid. 

 
 

Note: The same rectangular line grid can also be created using the free grid lines functionality.  Free 

grid lines allow the user to input grid lines anywhere in the graphical window and can be used to trace 

over grid lines that exist from an imported CAD file. 

Stories 

Add stories by double clicking on                   in the Line grid and stories service.  The building in this 
tutorial will consist of 5 stories, all 12ft high for a total building height of 60ft.  Create the stories as 
shown in the picture below, making sure to use the correct inserting point (0, 0) and then click OK. 
 

 
 

Once the stories have been added to the graphical window, click the Close button at the bottom of the 

Main Tree window to exit the Line grids and stories functionality. 

Base Point 
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Input a Floor Plate 

 

For this tutorial, the floor plate will consist of a concrete slab on top of a metal deck.  To input the 

proper extents of the floor plate, the imported .dwg drawing can be used.   

 

To do so, double click on the                    service and then click on the [+] to expand the 2D Member 

field.  Next, double click on  to open the plate input dialogue.  Once the dialogue appears, 

various properties of the plate can be manipulated. 

 

First, change the Analysis model type to Composite deck.  Doing so will launch the profiled sheeting 

library.  Click Cancel in order to close the dialogue.  In order to access the decking library, select the 

system database button         on the top toolbar.  Once the database is open, navigate the database to 

find 2 VLI 20 which is a 2” Vulcraft composite metal deck profile.  Also add the Vulcraft 1.5 B 20 metal 

deck which will be used later in the tutorial for the roof.  Click Copy to Project to add the profiles and 

then click Close and OK. 

 

Specify the remainder of the 2D member properties as follows: 

 Concrete deck material = C4000  

 Thickness = 4.50” (this is the total slab thickness) 

 Layer = Floor (create the new layer by clicking on the ellipsis button – 3 dots and then clicking 

New to add a new layer when the Layer dialogue opens) 

o With the layer dialogue open it is also possible to create additional layers that will be 

used later in the project.  Create the following layers; Walls, Beams, Columns, Braces, 

Joists, Panels 

 LCS Angle [deg] = 90° 

 

Once the plate has been defined properly, click OK to continue the graphical input. 
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By default, when entering a 2D member, the input drawing options are available in the command line.  

These options include modeling tools used to enter an arbitrary slab (by sketching lines or curves) or 

inputing a polygon.  For this tutorial, the edge of slab in the .dwg file is drawn as a polygon and 

therefore can be selected when using the Existing Polygon tool.  

 

 
 

Once the polygon has been selected right click in the graphical window and click End or simply press 

the ESC key to complete the command. 

 

Add Opening in Floor Plate 

After the floor plate has been added, it is necessary to create openings in the 2D member that 

correspond to the location of the elevator shaft and stairwell.  Before the openings are added, it is best 

to modify the model’s View Parameters.  To do this, click on the Fast adjustment of View 

Parameters button located on the View Parameters toolbar above the Command Line and then 

select Setup dialog. 

 

 
 

Enabled the checkbox for Show names in tab and then navigate to the                                         tab.  

Next, disable the checkbox for Grid Projection and click OK.  Then enable the rendering of the slab by 

selecting the button        on the toolbar. 

 

In the Structure service, expand the 2D member components field by clicking the [+] and then double 

click                   to begin to add the opening.  Click OK to close the dialogue.  The sketching tools for 

creating an opening are the same as the tools for creating a slab.  By default, the New polygon & 

straight line input buttons are selected.  Use this method of input to create the openings as shown in 

the picture below.  End the input of the opening by pressing the ESC key. 

 

Note: The extents of the opening lies on the centerline of the wall.  
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Note: The cursor snap settings (similar to object snap in AutoCAD) are used to easily select the 

endpoints and intersections that define the slab openings.  These snap settings can be modified using 

the cursor snap settings button        above the command line.  For this tutorial, the snaps for midpoints, 

end points, intersections, orthogonal points as well as the ability to snap to the line grid will be used. 
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Input Concrete Walls 

 

In this tutorial, there will be two concrete “core” wall elements which function as shear walls within the 

overall building lateral system. 

 

To create the walls, double click on the                    service and then click on the [+] to expand the 2D 

Member field.  Next, double click on              to open the wall input dialogue.  Once the dialogue 

appears, various properties of the wall can be manipulated.  Specify the properties as shown in the 

picture below and then click OK. 

 

 
 

When adding the walls, be sure to enable the REF layer so that the .dwg drawing that was added 

earlier is visible.  The wall systems are placed in two separate locations.  First, a “C” shaped core wall 

can be input near Grid Line B such that the walls follow the edges of the opening (as shown in the 

picture below).  Use the select line input to directly select the necessary opening edges for wall input. 
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The second “C” shaped core wall is input between Grid Lines C & D.  Again, the walls should follow the 

opening edge (along Grid Lines C & D) and along these lines should extend 1’-8” beyond the edge of 

the slab.  The .dwg drawing can also be used to properly add the walls as shown below. 

 

 
 

When the input is finished, press ESC to finish the command. 
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Input 1D members (columns, beams & joists) 

 

Before adding 1D members, the creation of additional layers that can be used to filter newly added 

elements (columns, beams, joists, braces, walls, etc.) can be created.  To do this, select the Layers 

button on the Project toolbar. 

 

Within the layers dialogue, create the following new layers: 

 

  
 

With layers created, Activities can be used to filter the model.  To enable the Activity by Layers, click 

the button found on the Activities toolbar. With the layer activity dialogue open, disable the check box 

next to the REF layer so that the current activity has only structural objects enabled.  Click Close to 

return to the graphical window. 
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Adding Columns 

From the Structure service, click on the [+] to expand the 1D member field and then double click on                  

       .  Since there are currently no cross sections added to the project, the New cross-section 

dialogue will appear.  Within the new cross-section dialogue, various types of cross sections (steel, 

concrete, thin-walled, etc.) can be added from within the available groups.  For this tutorial, the Profile 

Library group will be used to add all necessary steel cross sections. 

 

To add the wide flange cross section, select the profile shape,         , group W(Imp) and size 8x31 and 

then click the Add or  button.  The remainder of the cross sections for the tutorial can be added either 

manually or more efficiently by importing a database file (.db4).  To import the database file, click the 

Open button in the Cross-Sections dialogue. 

 

 
 

Next, navigate to the folder that contains the database file that was included with this tutorial, select the 

file and click Open.  The Read from database window will appear and all members can be added to 

the project by clicking the  button.  Click Close to finish the import.  With the import 

finished, the cross section library can be closed to continue the column input.  To finalize the input, 

select Col1 – W8x31 as the desire column cross section and also set the Length to 12ft.  Using the line 

grid intersections as the insertion points, add the columns (16 in total) in the graphical interface as 

shown in the picture below.  When the input is complete, press ESC. 

 

Note: Columns are not added at C3, D3 or E3 
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Adding Beams 

Before adding beams, it is necessary to move the composite floor to the appropriate elevation.  To do 

this, select the Move button on the Geometric Manipulations toolbar.  After clicking the move button, 

select the entities to be moved, in this case, the composite floor plate.  Finish the selection by pressing 

ESC.  Next, select the base of any column as the Start point for the move and the top of the same 

column as the End point of the command.  The composite floor plate should now be at the elevation 

which corresponds to the top of the columns and walls (12ft). 

 

 
 

Drawing beam elements in the graphical window can be accomplished using two 1D member input 

options.  When using the               functionality, the length and direction (X or Y) of the member must be 

defined from within the dialogue.  Alternatively, modeling with the                  functionality allows all input 

to be done within the graphical window. 

 

For this tutorial, it makes sense to use both input functionalities.  To make input easier, select the 

composite floor plate and then right click in the graphical window.  In the drop down menu that 

appears select Set view parameters for selected.  Then under the Structure tab change the setting 

for rendering to transparent.   

 

 
 

To begin the input of beams, use the                  input to connect the top nodes of all columns using 

cross section Bm3 – W14x26.  Additionally, some beams will connect to the core walls at either 

endpoints or orthogonal points (at C5 and D5). 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

21 

When the input is complete, there should be 28 beam members created as shown in the picture below. 

 
 

The                input can now be used to input the majority of the secondary framing members.  With the 

horizontal beam dialogue open, set the properties as shown in the picture below and click OK. 

 

 
 

Before input, access the cursor snap settings by clicking the button  on the command line and 

enable the points on line-curve – N-ths snap setting 
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This snap setting creates 1/3 points along each member so that the secondary framing members can 

be easily created.   

 

 
 

Note: Since the beam input functionality requires a length to be specified in the dialogue, the input 

using the beam functionality is different from the input using the member functionality in that only the 

start point of the element needs to be specified in the graphical window. 

 

Follow the steps between to input the remainder of the floor framing. 

 

Input #1: Beam Input, Bm9 – W12x26, Y direction, 20ft, begin insertion point (9 members) 
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Input #2: Beam Input, Bm1 – W10x19, Y direction, 10ft, begin insertion point (5 members) 

 

 
 

Input #3: Beam Input, Bm4 – W14x22, Y direction, 24ft, end insertion point (6 members) 
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Input #4: Member Input, Bm9 – W12x26, snap from beam end point to wall orthogonal point (2 

members) 

 
 

Input #5: Beam Input, Bm6 – W10x17, X direction, 6.667ft, begin insertion point (2 members) 
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Input #6: Member Input, Bm2 – W12x22, snap from end point to end point (1 member) 

 
 

For the final input, use the copy command on the toolbar and select the member shown in the picture 

below.  With the member selected, select the start point as one of the nodes of the beam and for the 

end point type 4 and press ENTER.  Finish the command by pressing ESC. 

 
 

 
 



 

26 

Note: When using the copy command, make sure the tracking mode for the graphical window is 

enabled.  This will enable the tracking lines when using modeling commands.  As shown in the picture 

below, the red tracking line represents the x direction, meaning that typing in the distance for the copy 

while the tracking line is present will place the new member on that same line. 

 

 
 

 

 
 

With the modeling of the floor members complete, enable the member labels by selecting the button on 

the view parameters toolbar above the command line. 

 
 

To switch the labels from the beam number to the cross section type, right click in the graphical 

window and select set view parameters for all.  Next, choose the Labels tab and change the active 

beam labels checkbox from name to cross section type.  With the labels active it is easy to make 

member cross section changes from within the Property window. 
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First, select the 8 exterior girder members and change the CrossSection from Bm3 – W14x26 to Bm7 

– W14x30. 

 
 

Next, select the 5 interior girder members and change the CrossSection from Bm3 – W14x26 to Bm8 

– W16x31. 
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Next, select the 2 interior girder members and change the CrossSection from Bm3 – W14x26 to Bm5 

– W14x22. 

 
Select the 5 exterior beam members that frame into columns and change the CrossSection from Bm3 

– W14x26 to Bm2 – W12x22. 

 

 
 

 



 

 

29 

With the modification of all the member sizes complete, the beams can now be connected compositely 

to the floor plate.  To do this, select the Connect Member/Nodes functionality on the geometric 

manipulation toolbar and click OK to proceed with all entities. 

 

 
 

Within the setup for the connection of elements, enable the checkbox for Connect 1D members as 

ribs and then click OK.  The beams are then switched to member type, plate rib and are connected to 

the composite floor plate.  After the connection, modifications should be made to the properties of all 

composite members.  To make changes for all members at the same time, select any plate rib member 

and then click on the Type of connection property (highlighted below in blue below).  With the property 

selected, click on the select elements by property button, which is defined by a lightning bolt as seen 

below.  This will create a selection that includes 54 beam elements. 

 

 
 

With all 54 beam elements selected change the type of connection from user-defined eccentricity to 

with standard composite action.  With the selection still active, change the property for shape of rib 

from T symmetric to automatic.  When the modifications are complete, press the ESC key to end the 

command. 

 

Note: The setting for automatic shape of rib will automatically calculate the appropriate effective width 

of each beam element.  The setting for standard composite action is used to eliminate axial forces 

caused by eccentricity between the floor plate and connected beam element. 

 

With the composite members added, it is also necessary to add hinges on the beams to eliminate any 

moment transfer at the connection points.  To do this, first make sure all 54 beam elements are 

selected, then navigate to the Hinge on beam functionality found in the Structure service under Model 

data.   
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Once the hinge on beam dialogue opens, set the properties as shown in the picture below and click OK 

to add the hinges. 

 

 
 

Note: Hinges can be viewed graphically by enabling Show/Hide other model data from the view 

parameters toolbar. 
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Adding Lateral Braces 

In addition to shear walls, the lateral system will include braced frames on all floors.  The braced frames 

are modelled using the                 functionality and cross section Bm10 – HSS4x4x1/4.  Add the two x-

braces along Grid Line A (between 1 & 2) and along Grid Line 2 (between C & D). 

 

Additionally, with both braces still selected double click on                    found in the Structure service 

under Model data.  Cross-links are added in order to create a rigid, pinned or coupled connection 

between two bracing members.  Once the cross link dialogue opens, change the Type to hinged and 

click OK.   

Creating elements on additional stories 

Once the walls, column, beams and braces are all added to the model, the elements can be copied to 

the other floors.  To do this, select all the elements in the model and click the multi-copy button on the 

geometric manipulation toolbar. 

 

 
 

With the multi-copy dialogue open, set the number of copies to 3, disable the define distance by 

cursor checkbox so that the value for z can be set to 12ft.  When the properties of the multi-copy are 

set, click OK. 
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Next, click the View in direction Y button on the View toolbar to change the 3D view of the model and 

select all column, brace, wall and floor elements on the 3rd level as shown in the picture below.  Do not 

select the floor beams, they will be individually selected in the next step. 

 

 
 

 
Use the activity by selection functionality, found on the Activity toolbar to filter the selection so only 

the currently selected elements are visible in the graphical window. 
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Select the following beam members (17 total), in addition to all columns, braces, walls and the floor 

plate visible. 

 
 

Use the multi-copy command and set the number of copies to 1, disable the define distance by 

cursor checkbox so that the value for z can be set to 12ft.  When the properties of the multi-copy are 

set, click OK. 

 

When the copy is complete, use the activity by selection functionality to filter the selection so that only 

the elements on the 5th floor are visible. 
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Adding roof joists 

Most composite steel buildings utilize metal roof deck and steel bar joists as the main structural system 

for the roof.  In this tutorial, virtual joists will be added to complete the roof framing.  Virtual joists are 

1D member elements created by the Steel Joist Institute for use in finite element analysis software.  For 

more information concerning virtual joists and their implementation within SCIA Engineer, refer to the 

Virtual Joist Manual. 

 

Before modeling the joists, new virtual joist cross sections need to be added to the library.  To do this, 

click the cross section library button on the Project toolbar.  When the dialogue of active cross 

sections appears, click New.   

 

 
 

At the bottom of the list of available groups select                      and then click the [+] button to expand 

the VJ group of items.  The items in the VJ list are separated by joist depth.  For this tutorial add three 

separate VJ members: VJ10-1, VJ16-1 and VJ20-1.  When each joist cross section is added, make 

sure to switch the base steel material to A529 Grade 50. 

 

  
 

Before the joists and other roof framing members can be added the decking type and extents of the 

plate need to be modified.  First, select the plate that was copied to the roof level and change the 

analysis model type and profiled sheeting to match the picture below. 

 

 
 

Next, the opening for the stairwell needs to be eliminated.  This can be done by adding a second plate 

or by manipulating the geometry of the slab directly.  Before choosing to manipulate the slab geometry, 

http://downloads.scia-online.com/support/sciaengineer/manuals/15/us/sji%20virtual%20joist%20&%20joist%20girder%20manual_v15.pdf
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it is important to understand which nodes need to be modified.  This can easily be done by enabling the 

node labels from the view parameters toolbar.   

 

 
 

Once the nodes are identified, it is possible to select the roof plate and click the Table Edit Geometry 

button found in the Actions list at the bottom of the Properties window. 

 

 
 

The two nodes that need modified can be easily found by sorting the table for editing geometry by 

clicking the Y [ft] column.  Both nodes have a Y value of 58.6667 ft, which needs to be changed to 

66.3333 ft.  When the change has been made, click the Apply button and then click OK. 

 

Once the roof plate has been modified the necessary roof framing members (joists and secondary 

beams) can be added by using either the Member or Beam input functionality found in the 1D Member 

service. Add all additional framing members as shown in the picture on the next page. 

 

Note: All virtual joist members are placed at a spacing of 5’ on center.  To achieve this easily utilize the 

cursor snap setting, points on line-curve – N-ths.  Additional beam members are also added near 

the elevator and stairwall as shown in the picture on the next page. 
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Before the input of the framing can be complete, the composite beams that were copied from the floors 

below need to be changed to non-composite members.  To do this, select all (17 members) and 

change the type of connection to without composite action.  This will eliminate the effective width of 

the members and make them act non-compositely. 

 

To finish the modeling of the roof structure, the framing members need to be properly connected to the 

roof plate.  To do this, select the plate and then select the functionality from Structure > 

2D member > 2D member components.  Then using the select line input tool select all virtual joist 

and newly added roof beam members (52 in total).   

 

 
 

This will add an internal edge at each member, thus creating the appropriate finite element connection. 

 

Finally, add hinges on the beams to all members, joists and beams (69 in total) with the following 

settings modified: 

 Position = Both 

 fiy and fiz = Free 

 

Note: The layer settings of each member can be modified as well.  Set the layer for members (beams, 

columns, walls, floors, braces and joists) accordingly. 
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Input Supports 

 

Once the structure has been modelled, support conditions can be added to the base of the columns 

and walls.  Adding supports is possible by navigating to Structure > Model data > Support.   

 

 

 

 

  

In this tutorial, supports in node will be used at the base of all 1st floor columns.  To add these 

supports, double click on in node and configure the supports as shown below.  Once the properties are 

set, click OK and select the nodes at the base of the column elements (16 in total). 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

In addition to supports at the base of the columns, line supports at the base of the elevator core and 

stairwell are required as well.  For these elements, use the                                        support type and 

set the properties for the support as shown below.  Once the properties are set, apply the line supports 

along the base of all concrete walls (6 in total). 
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Load Panels 

 

Part 2 of the tutorial will focus on loading, including the application of wind loading through the use of 

SCIA Engineer’s 3D Wind Load Generator.  In order for the wind load generator to work properly, the 

structure must include load panels which wrap the exterior of the building.  Load panels have no 

weight, no in-plane stiffness and function solely as a 2D member which distributes load to connecting 

members. 

 

To begin the input, expand the                          functionality from within the Structure service.  In this 

tutorial,                                                 will be used so that the applied loads are distributed properly to 

specific members, primarily the edges of the floor plates (diaphragms).  After the proper type of load 

panel is selected, the panel dialogue will open and the properties of the panel can be set as shown 

below. 

 

 
 

Load panels are required to be planar, therefore a panel should be modelled on each exterior frame 

line such that there are no gaps.  This will allow the 3D wind to be properly applied to the structure.  In 

total there should be 13 load panels created (with all panels having a load transfer direction, Y 

(LCS).  The list below will help define the extents of each panel in addition to any modeling tips. 

 

Note: Panels are created along the grid lines such that there is a small edge of the floor plates which 

would be considered “outside” of the structure.  For this tutorial, this is acceptable. 

Input Load Panels 

LP1: Along Grid Line 1 (between Grid Lines A & C) 

LP2: Along Grid Line C (between Grid Lines 1 & 2) 
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LP3: Along Grid Line 2 (between Grid Line C & intersection of N49 & N100) 

 

Note: To identify the intersection which defines the lower right corner of the load panel, temporary 

tracking points (nodes with light blue boxes around them) can be created by holding SHIFT and 

clicking on the node.  Once both tracking points are created the intersection between the two will be 

identified and the point can be selected as shown in the picture below. 

 

 
 

LP4: In the same plane as beam B71 (between Grid Lines 2 & 4) 
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LP5: Along Grid Line 3 (between LP4 and Grid Line E) 

 

 
 

LP6: Along Grid Line E (between Grid Lines 4 & 5) 

LP7: Along Grid Line 5 (between Grid Lines D & E) 

LP8: Along Grid Line 5 (between Grid Lines A & C) 

LP9: Along Grid Line A (between Grid Lines 4 & 5)  

LP10: Along Grid Line 4 (between Grid Line A & intersection of N65 & N103) 
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LP11: Along Grid Line 3 (between Grid Line A & intersection of N37 & N102) 

 

Note: LP11 should be created using the mirror function.  To complete this process, select the 

previously created LP10 and then press the mirror         button.  Next, select the midpoint of beam B72 

as the start point of the mirroring plane.  Then select any point along the X axis vector line shown in the 

picture below to define the end of the mirroring plane.  Once the plane is defined, the command will ask 

if the original element should be removed, press No to end the command. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LP12: In the same plane as beam B72 (between LP10 & LP11) 
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LP13: Along Grid Line A (between Grid Lines 1 & 3) 

 

Finalize the input by selecting all of the load panels (13 in total) and changing the property for Layer to 

Panel. 

 

 

 

 

 

 

 

 

 

 

 

 

When the input of all load panels is complete, the structure should look as shown in the picture below. 

 

 
 

The input of load panels concludes the modeling portion of the tutorial.  Save the model (File > Save) 

and then proceed to Part 2 – Loading of the tutorial by visiting the Manuals and Tutorials section of the 

website to download the PDF. 

 

https://www.scia.net/en/support/downloads/scia-engineer-manuals-tutorials

